
Class: 9th

Subject: Biology

Chapter 11: Biostatistics

Exercise MCQs:

1. What is the primary purpose of biostatistics?

a) To analyse financial data

b) To apply statistical methods to biological

sciences ✅

c) To design engineering models

d) To study historical events

2. In biostatistics, which method is used to predict

future outcomes based on current data?

a) Designing experiments

b) Drawing charts

c) Taking average



d) Analysing data ✅

3. Which of the following best describes the mean

of data set?

a) The most frequently occurring value

b) The middle value when data is ordered

c) The sum of all values divided by the number of

values ✅

d) The difference between the highest and lowest

values

4. If the data set is 5, 8, 12, 15, 20, what is the

median?

a) 8

b) 12 ✅

c) 15

d) 20

5. What is the mean of the data set: 7, 8, 9, 10, 11?

a) 7

b) 8



c) 9 ✅

d) 10

6. When the number of values in a data set is even,

how is the median calculated?

a) By choosing the middle value

b) By taking the average of the two middle values

✅

c) By selecting the most frequent value

d) By adding all values and dividing by the total

number of values

7. In a data set with values 3, 3, 6, 7, 8, 9, 9, what is

the mode?

a) 3

b) 6

c) 7

d) Both 3 and 9 ✅

8. If a data set has no repeated values, what is the

mode?

a) The highest value



b) The average of the data set

c) There is no mode ✅

d) The median value

9. In a bar chart, what does the height or length of

each bar represent?

a) The total number of categories

b) The value of the corresponding category ✅

c) The average of all values

d) The difference between the highest and lowest

values

10. When constructing a bar chart, which axis

usually represents the categories?

a) Vertical axis (y-axis)

b) Horizontal axis (x-axis) ✅

c) Both axes equally represent the categories

d) Neither axis represents the categories



Important MCQs:

1. Which of the following is the branch that applies

statistical methods to biological sciences?

(a) Chemistry

(b) Geology

(c) Biostatistics ✅

(d) Anatomy

2. Biostatistics is mainly used for:

(a) Drawing biological diagrams

(b) Designing experiments ✅

(c) Writing research papers

(d) Collecting fossils

3. In clinical trials, biostatistics helps in

determining:

(a) Cost of medicine

(b) Number of doctors

(c) Sample size ✅

(d) Hospital location



4. Biostatistics helps in:

(a) Reading novels

(b) Making perfumes

(c) Analyzing biological data ✅

(d) Teaching grammar

5. Predicting the spread of a disease in a

population is a function of:

(a) Geography

(b) Biostatistics ✅

(c) Botany

(d) Architecture

6. Which of the following is an example of

interpreting results in biostatistics?

(a) Measuring rainfall

(b) Testing soil type

(c) Analyzing disease survey ✅

(d) Mixing chemicals

7. Biostatistics supports public health by:



(a) Building clinics

(b) Giving health advice

(c) Guiding policies through data ✅

(d) Treating patients directly

8. Epidemiologists use biostatistics to study:

(a) Skin types

(b) Hair colour

(c) Disease distribution ✅

(d) Climate change

9. In genetics, biostatistics is used to:

(a) Develop vaccines

(b) Analyze genetic inheritance ✅

(c) Measure blood pressure

(d) Study weather patterns

10. Which of the following uses biostatistics to

compare wheat yield?

(a) Botany

(b) Agriculture ✅



(c) Zoology

(d) Astronomy

11. Clinical trials use biostatistics to:

(a) Diagnose diseases

(b) Provide ambulance services

(c) Test new drugs and treatments ✅

(d) Print medicine labels

12. The measure that gives an average of a data

set is called:

(a) Median

(b) Mode

(c) Mean ✅

(d) Range

13. What is the formula for mean?

(a) Highest ÷ Lowest

(b) Total values ÷ Number of values ✅

(c) Most repeated value

(d) Largest value – Smallest value



14. What is the mean of the following data set: 150,

160, 165, 155, 170?

(a) 155

(b) 165

(c) 160 ✅

(d) 150

15. Which of the following identifies the most

frequent value in a data set?

(a) Mean

(b) Median

(c) Mode ✅

(d) Average

16. What is the median of the data set: 150, 160,

165, 155, 170?

(a) 155

(b) 160

(c) 165

(d) 160 ✅



17. Which step is performed first to calculate the

median?

(a) Find mean

(b) Create a graph

(c) Arrange data in ascending order ✅

(d) Count mode

18. If a data set has an even number of values, the

median is:

(a) The middle value

(b) The average of two middle values ✅

(c) The highest value

(d) The mode

19. What is the median of the data set: 150, 155,

160, 165?

(a) 155

(b) 157.5 ✅

(c) 160

(d) 165



20. What is the mode of the data set: 150, 160, 165,

155, 160?

(a) 150

(b) 155

(c) 160 ✅

(d) 165

21. A data set is said to be bimodal if:

(a) All values are equal

(b) It has two modes ✅

(c) It has no mode

(d) Median and mean are equal

22. What is the mode of the data set: 150, 160, 160,

155, 155?

(a) No mode

(b) 160 only

(c) 155 only

(d) 160 and 155 ✅



23. If all values in a data set occur only once, the

mode is:

(a) The smallest value

(b) The largest value

(c) The average

(d) No mode ✅

24. A bar chart represents data using:

(a) Circles

(b) Lines

(c) Bars ✅

(d) Arrows

25. In a bar chart, the x-axis usually represents:

(a) Quantities

(b) Categories ✅

(c) Frequencies

(d) Time



Exercise Short Questions:

1. Define biostatistics:

Biostatistics is the application of statistical

methods to biological and health-related studies.

2. What is the median of a data set?

The median is the middle value of a data set when

the values are arranged in ascending or descending

order.

3. How is the mean calculated?

The mean is calculated by dividing the sum of all

values by the total number of values.

4. What does the height of a bar in a bar chart

represent?

The height of a bar represents the value or

frequency of the corresponding category.

5. What is the mode of a data set?

The mode is the value that appears most frequently

in a data set.



Important Short Questions:

1. What is biostatistics?

Biostatistics is a branch of statistics that applies

statistical methods to biological sciences.

2. How does biostatistics help in designing

experiments?

It helps in planning and structuring experiments to

ensure the data collected is relevant and sufficient.

3. What is the role of biostatistics in analyzing

biological data?

Biostatistics helps in finding trends, patterns, and

correlations in biological data.

4. How does biostatistics assist in interpreting

results?

It helps to make sense of analyzed data to guide

scientific and public health decisions.

5. How is biostatistics used to predict outcomes?

By using statistical models, it predicts future events

based on current data.



6. What is the importance of biostatistics in public

health?

It provides evidence-based insights for making

health policies and guidelines.

7. How do epidemiologists use biostatistics?

They use it to study disease patterns, distribution,

and control in populations.

8. What is the application of biostatistics in

genetics?

It is used to analyze the inheritance of traits and

identify disease-related genetic markers.

9. How is biostatistics useful in agriculture?

It helps in analyzing crop yields and the effects of

fertilizers or pest resistance.

10. What is the role of biostatistics in clinical trials?

It is used to design and analyze trials to test the

effectiveness and safety of new treatments.

11. What is the mean in biostatistics?

Mean is the average of all values in a data set,



found by dividing the sum of the values by the

number of values.

12. Write the formula for calculating mean.

Mean = Sum of all data points / Number of data

points

13. What is the median?

Median is the middle value in an ordered data set. If

the number of values is even, it is the average of the

two middle values.

14. How do you calculate the median when the

number of values is odd?

Arrange the data in order and pick the value at the

position (n + 1)/2.

15. How do you calculate the median when the

number of values is even?

Find the average of the values at positions n/2 and

(n/2 + 1) after arranging in order.

16. What is the mode in a data set?

Mode is the value that appears most frequently in a



data set.

17. Can a data set have more than one mode? Give

an example.

Yes, for example, in the data 150, 160, 160, 155, 155

– both 160 and 155 are modes (bimodal).

18. What is a bar chart?

A bar chart is a graphical representation of data

using bars of different heights to compare

categories.

19. What are the main steps to create a bar chart?

Collect data, organize it, draw axes, label them,

decide the scale, draw bars, and label each bar.

20. Why are bar charts useful in biostatistics?

Bar charts help visually compare different

categories and understand data distribution clearly.

Exercise Long Questions:

Q1: Explain the importance of biostatistics in the

field of public health. Provide examples of how it is



used to inform public health decisions.

Answer:

Biostatistics plays a crucial role in public health by

providing tools and methods to collect, analyze, and

interpret biological and health data. It helps public

health professionals understand health trends,

disease outbreaks, and the effectiveness of health

interventions, which is essential for making

informed decisions.

Importance of Biostatistics in Public Health:

Disease Surveillance and Control: Biostatistics

helps track the spread of diseases in populations.

For example, during an epidemic like COVID-19,

biostatistical methods are used to analyze infection

rates, recovery rates, and mortality rates to monitor

the disease progression and evaluate the impact of

control measures.

Designing Health Programs: By analyzing data on

risk factors and disease prevalence, biostatistics

aids in planning vaccination campaigns, screening

programs, and preventive strategies. For example,



data on the prevalence of diabetes in a community

helps design targeted health awareness programs.

Evaluating Treatments and Interventions:

Biostatistics allows public health officials to assess

the effectiveness of treatments, vaccines, and

health policies by comparing outcomes in different

groups. Clinical trials use biostatistics to determine

whether a new drug works better than existing

treatments or placebos.

Resource Allocation: Statistical models predict

future health care needs, helping governments and

organizations allocate resources effectively. For

instance, predicting the spread of infectious

diseases helps in planning hospital beds, medical

supplies, and vaccination distribution.

Examples:

 During the COVID-19 pandemic, biostatisticians

analyzed data on infection rates and vaccine

effectiveness, which guided governments on

lockdown policies and vaccination drives.

 Epidemiologists use biostatistics to study the



risk factors of heart disease by analyzing data

on diet, exercise, and smoking habits.

 In malaria control programs, statistical analysis

helps evaluate the impact of insecticide-treated

nets on reducing malaria cases.

In summary, biostatistics is vital in public health for

making evidence-based decisions, improving health

outcomes, and efficiently managing health

resources.

Q2: Discuss the differences between mean,

median, and mode. Include examples where each

measure is most appropriate to use.

Answer:

Mean, median, and mode are three important

measures of central tendency used to summarize

and describe data sets. Each measure has different

characteristics and is suitable in different situations.

Mean:

 The mean, or average, is calculated by adding

all data values and dividing by the total number



of values.

 It represents the overall average of the data.

 Example: The average height of students in a

class can be found using the mean.

 When to use: The mean is best used when data

are evenly distributed without extreme outliers,

as it is sensitive to very high or low values.

Median:

 The median is the middle value when the data

are arranged in ascending or descending order.

 If there is an odd number of values, the median

is the middle one; if even, it is the average of

the two middle values.

 Example: In income data where some people

have extremely high earnings, the median

income gives a better idea of the "typical"

income than the mean.

 When to use: The median is useful when data

contain outliers or skewed distributions, as it is

not affected by extreme values.



Mode:

 The mode is the value that appears most

frequently in the data set.

 There can be one mode (unimodal), more than

one mode (bimodal or multimodal), or no mode

if all values are unique.

 Example: In a survey of favorite fruits, the

mode would be the fruit chosen by the most

people.

 When to use: The mode is suitable for

categorical data or when identifying the most

common item or category in a data set.

Q3: Describe the steps involved in creating a bar

chart using Excel. Include a discussion on how to

customize the chart for better visualization and

interpretation of data.

Answer:

Creating a bar chart in Excel is a straightforward

process that allows you to visually compare

different categories of data. Here are the detailed



steps and tips for customization:

Steps to Create a Bar Chart:

1. Prepare Data:

Organize your data in columns or rows. For example,

list categories (e.g., species or product names) in

one column and corresponding values (e.g.,

quantity or sales) in the adjacent column.

2. Select Data:

Highlight the data range that you want to include in

the bar chart, including category labels and values.

3. Insert Bar Chart:

Go to the Insert tab in Excel’s ribbon menu.

Click on Insert Column or Bar Chart icon.

Choose the type of bar chart you want (e.g.,

clustered bar, stacked bar).

4. Chart Creation:

Excel will generate a bar chart based on the

selected data and insert it into the worksheet.

Customization for Better Visualization:



Add Titles:

Add a chart title and axis titles to make the chart

understandable. Use the Chart Tools > Design > Add

Chart Element > Chart Title.

Adjust Axis Labels:

Ensure the x-axis (categories) and y-axis (values)

are clearly labeled. You can format the axis labels

for better readability.

Change Colors:

Use different colors for bars to distinguish

categories clearly. Right-click on bars and choose

Format Data Series to change colors.

Modify Scale:

Adjust the y-axis scale to fit the data range properly.

This helps in better comparison.

Add Data Labels:

Show exact values on the bars by enabling data

labels. Go to Chart Tools > Layout > Data Labels.

Spacing and Bar Width:



Customize the gap width between bars and the

width of bars for better appearance.

Legend:

Include or modify the legend if the chart has

multiple data series.

Interpretation:

A well-customized bar chart helps quickly

understand which categories have higher or lower

values. It visually highlights comparisons, trends,

and differences in data, making interpretation

easier for presentations and reports.

Q4. Provide a detailed example of how to calculate

the mean, median, and mode of a data set. Use the

following data set for your calculations:

12, 15, 22, 8, 19, 25, 15

Answer:

We will calculate the mean, median, and mode step

by step for the given data set.

Step 1: Organize the Data



 Given data set:

 12, 15, 22, 8, 19, 25, 15

 Arrange the data in ascending order for easier

calculation of median:

 8, 12, 15, 15, 19, 22, 25

Step 2: Calculate the Mean

Mean is the average value of the data set. It is

calculated by adding all the numbers and dividing

by the total number of values.

Sum of values = 8 + 12 + 15 + 15 + 19 + 22 + 25 =

116

Number of values = 7

So,

Step 3: Calculate the Median

 Median is the middle value of the data when it



is arranged in ascending order.

 Since there are 7 values (an odd number), the

median is the value at position 7+1/2= 4.

Counting the values in order:

1st: 8

2nd: 12

3rd: 15

4th: 15 ← Median

5th: 19

6th: 22

7th: 25

So, the median is 15.

Step 4: Calculate the Mode

Mode is the value that appears most frequently in

the data set.

Count the frequency of each value:

 8 appears 1 time

 12 appears 1 time



 15 appears 2 times

 19 appears 1 time

 22 appears 1 time

 25 appears 1 time

Since 15 appears twice and all other values appear

only once, the mode is 15.

Summary:

 Mean = 16.57

 Median = 15

 Mode = 15

Q5: You are given the following data set, create a

bar chart to represent the number of different

types of fruits sold at a market in one week:

 Apples: 30

 Bananas: 45

 Oranges: 20

 Grapes: 25

 Mangoes: 15



Ensure to label the axes and provide a title for the

chart.

Answer:

Since I cannot draw the chart here directly, I will

explain how to create the bar chart step by step and

how it would look.

Step 1: Prepare the Data

Fruit Number Sold

 Apples 30

 Bananas 45

 Oranges20

 Grapes 25

 Mangoes 15

Step 2: Draw the Axes

 Draw a horizontal axis (x-axis) and a vertical

axis (y-axis).

 Label the x-axis as "Types of Fruits".

 Label the y-axis as "Number of Fruits Sold".



Step 3: Determine the Scale of Y-Axis

 The highest value is 45 (Bananas).

 Choose a scale that can cover values from 0 to

at least 50, using intervals of 5 or 10 for clarity.

Step 4: Draw Bars

 For each fruit, draw a vertical bar above its

name on the x-axis.

 The height of the bar corresponds to the

number of fruits sold.

For example:

 Apples: bar height to 30

 Bananas: bar height to 45

 Oranges: bar height to 20

 Grapes: bar height to 25

 Mangoes: bar height to 15

Step 5: Title the Chart

Add a title at the top such as:

"Number of Different Types of Fruits Sold at Market



in One Week"

Result Interpretation:

 The tallest bar will be for Bananas, indicating it

is the most sold fruit.

 Mangoes will have the shortest bar.

 The bar heights visually show the comparison

of quantities sold.

Note:

 This chapter is designed to provide a solid

foundation of knowledge, with the goal of

deepening understanding and encouraging further

exploration of the subject. The content has been



carefully selected to support effective learning and

inspire students to engage with the topic more

deeply.
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